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Introduction

Conventions Used in this Document

This do

>
O

not incl

*

L

cument uses the following conventions:

The names of screens, windows, fields, and other features displayed by the software are shown
in bold type.

Information you enter into the software is in bold type, as in the following example: Enter
Miscellaneous in the Amount Type box.

Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK]
and [Post].

Helpful information to make your experience better.

NOTE: This symbol draws your attention to information of particular interest, such as information
uded in steps.

CAUTION: This symbol draws your attention to information that is important because it can help

you avoid a costly or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Introduction

MyAssistant Upgrade Guide

This document steps you through upgrading to and configuring Sage 300 CRE MyAssistant 18.1.5. If you are
installing the MyAssistant software for the first time, please refer to the MyAssistant Installation Guide
included in the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps:

1. Upgrade the MyAssistant Server software.

2. Upgrade the MyAssistant database and confirm previous settings by completing the MyAssistant
Configuration Wizard.

3. (Optional) Upgrade the MyAssistant Drive Mapper.

4. Upgrade MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant is
used.

Upgrading the MyAssistant server should take approximately 30 minutes. Upgrading each MyAssistant
workstation should take approximately 10 minutes.

E CAUTION: MyAssistant 4.0 and higher can upgrade directly to MyAssistant 18.1.5. If you are
running MyAssistant 3.x or earlier, upgrade to MyAssistant 4.2 before upgrading to MyAssistant 18.1.5. If
you upgrade from an unsupported path you risk corrupting your MyAssistant data.

Before You Begin

o Determine the computer where the MyAssistant server software is currently installed. It is most likely
on your Sage 300 CRE server.

e Log in to the server using the Windows username that was most likely used to install and activate the
MyAssistant server. Most often this is a Windows Administrator account.
Create a backup of your MyAssistant database prior to upgrading the software.
Ensure the latest Microsoft Windows and Microsoft Office updates have been installed. Installing the
High Priority updates is recommended.

¢ Confirm all machines where MyAssistant will be installed are running Sage 300 CRE 18.2, including
the MyAssistant Server.

Restart the MyAssistant server prior to performing the upgrade. This will complete any Windows
or other software updates where a restart is required.

Support and Training

Telephone Support

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone
support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following
exceptions:

e Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)

e Standard United States holidays

e Quarterly company meetings

Upgrade Guide Page 6



Introduction

Sage Customer Portal

You may log on to the Sage Customer Portal at:
https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:
¢ Knowledgebase: Find answers to your questions, access downloads, and subscribe to your
favorite articles. This service is available online 24/7.
e Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat
hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as
telephone support.

® Online Support Request: If you have a question or an issue that is not urgent, you can submit an
online support ticket. A customer support analyst will contact you during regular telephone
support hours.

Education & Training

Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available
and upcoming classes.

How to access MyAssistant training options in Sage University:
1. Enter www.SageU.com in your web address bar.
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Inthe page that opens, click [Product Training] on the left side of the screen.
Click [MyAssistant] in the list that opened.
Select either [Realtime Learning] or [Replay Leaning] and review the available options in each.

oA

How to access Complimentary MyAssistant Training in Sage University:
1. Enter www.SageU.com in your web address bar.
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the
MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.

Upgrade Guide Page 7
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Back Up the Database

Chapter 1 — Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant
database.

1. Log in to the MyAssistant server using the Windows account used to install and activate the
MyAssistant Server. This is often an Administrator account.

al| 2. Open the MyAssistant Configuration Manager using the icon on your desktop (pictured left), or
L by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant Configuration

Manager
3. Click the tab labeled MyAssistant Database Connection

4. Click [Backup Database...] (highlighted below)

@ My Assistant Server Configuration Manager =3 2

Connect to the Mylssistant Database 2

Product Activation

| Myhssistant Database Connection Uze the fields below to enter the computer name where the SOL Server database is installed
and to create a SOL Server user,

Sage 300 CRE Data Folders

Enter the computer that the database is located at:
Matification E-Mail Accounk Server Mame WINZOOERS

Serwer Options Create a usernanne and passward For MyAssiskant ko access

the SGL Server:
ser Marne My Assiskant
F‘asswl:lrd sk ks

Re-enter Password: | s

Show characters

Advanced Connection Settings Test Settings, ..
Instance name: | 15D Backup Database. .. ]
\ Database name: | Mobification
S Port number: 45312
R
OE,
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Back Up the Database

5. In the new window that opens, select the location where the backup of the database will be
stored. A default location will be prefilled, but can be changed by typing into the text box or using
the [...] button to the right of the text box.

@ Backup Database

=

= =2

| Backup Location

Create MyAssistant Database Backup.

Select the location ko store the generated backup and click the button [Backup MyAssistant Database] to
camplete your backup.

Backup Location: CiUsers\AdministratoriDocunentsiMyAssistantBackup_06_24_2014.bak

Backup Mydssistant Database

6. After selecting a backup file location, click [Backup MyAssistant Database]

7. When the process has completed, a message will appear that states the backup was successful,
and will list the folder location where the backup was saved.

8. After finishing, click [OK].

Now that your MyAssistant database has successfully been backed up, continue with the upgrade of your

MyAssistant software.

Upgrade Guide
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Server Upgrade

Chapter 2 — Upgrading the MyAssistant Server
Perform the following to initiate the MyAssistant Server upgrade.

1. (Optional) Log on to your Sage 300 MyAssistant server with a Windows user that has
Administrator or Unlimited permissions. You do not need to do this step if you already logged in
as an administrator to back up your MyAssistant database.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running on the server.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is
accessible from all workstations where MyAssistant will be installed.

Perform the following to initiate the MyAssistant Server Upgrade:

a) Open the location of the downloaded MyAssistant Installation files.

b) Unzip the files to a folder in the same shared folder the .ZIP file was placed.

c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open:

Sage 300

Construction and Real Estate

MyAssistant

Version 18.1.5
» View Installation Guide.

» Install Server.

» Install Workstation.

SageCRE.com | Exit |

Click [Install Server] to start the MyAssistant Server upgrade.
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Server Upgrade

Step 1 — MyAssistant Server Upgrade

The MyAssistant Installation wizard displays once you have selected the type of install.

m My Assistant - Setup Server E

Welcorme to the Myfssistant Server Instaler

W elconme

Thiz wizard will quide you through the Mudsgistant inztallation process, vou
may be asked to restart vour system after installing prerequisites.

®  Prerequizites

&  Myphsszistant

Before continuing inztallation, please cloze all applications [such az Microsoft
Outlook, Wirue Scanners, and Spiware Detectors), gsince they can interfere
with the My Aszistant installation.

Meut » Cancel

Click [Next] to continue.
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Server Upgrade

Step 2 — MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE
MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation
files.

m MyAssistant - Setup Server E

License Terms for MyAssistant Server

License Tems IMPORTANT - READ CAREFULLY: Ths i’
Software License Agreement (the “Agreement”™)
15 a legal agreement between you - either an
individual or a single entity - the (“Licensee™) and
Innovative Software Design, Inc. (“ISD™). Tls
Agreement applies to the computer sofftware,
tachine readable form, that accompardes this
Agreement (the “Eoftware™, updates,
documentation and related serwices.  TOT
AGEEE TO BE BEOTUND BY THE TEEMSE OF
THIS AGEEEMNT BY CLICEING *I
ACCEPT THE  TEEMS OF  THIZ
AGEEEMENT, INETALLING, COPTING,
OF TTEING THE SOFTWARE. IF YO DO
MOT AGEEE, DO NOT INSTATL, COPY,
OFE USE THE SOFTWARE, YOU MAY
EETUEX IT TO TYOUE PLACE OF
PURCHASE FOR A FULL REEFTTND.

[
W1 accept the terms in the license agreement

Mewut » Cancel |

If you agree to the terms of the License Agreement, check the | accept the terms in the license agreement
checkbox and click [Next] to continue.
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Server Upgrade

Step 3 — Prerequisites for MyAssistant Server

This window displays the prerequisite software, if any, that MyAssistant will need upgrade. Click [Next] to
update your prerequisite software.

CAUTION: Itis only recommended that you check the box next to “Do not upgrade SQL Server
Express” if you or your IT support has already installed your own version of SQL Server 2012 or later to
use with MyAssistant (including any full versions of SQL Server your company has purchased).
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Server Upgrade

Step 4 — MyAssistant Software

In this step you will determine where the updated MyAssistant Program Files will be installed on your
server.

m MyAssistant - Setup Server E

My fssistant Server

The default location where the Mydssiztant program files will be installed
to iz C:AProgram Filez' nnovative Software Designhhdy Azziztants. Tou
may uze the Browse button to specify a different location on your local

. camputer.
Inztall Mudzsistant

Select a location to install Mydszistant:

IC:'\F'rogram Fileg [#36] nnowative Software Designibdy desistant

Browse... |

Mest » Cancel

Accept the default location or use the [Browse] button to specify a different location. It is recommended that
you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant Server software.
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Server Upgrade

Step 5 - You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

m My Assistant - Setup Server E

You have completed instaling MyAssistant Server

Congratulations! 'ou have finizhed instaling the Mubdszistant Server. The
tpdzzistant Server must be activated and configured to run. To activate the
gerver, 1un the Mydasistant Configuration banager.

Firished

Click [Finish] to close the wizard and have the option to continue to the Configuration Manager.

NOTE: You must step through the Configuration Manager on the server before upgrading
MyAssistant on any Workstations.
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Server Upgrade

Step 6 — Start the MyAssistant Configuration Manager
After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

MyAssistant - Setup Server

3 1 Your Myhssiskant Server needs to be configured before it can be
V' used,

Do wou want o run the MyAssistant Configuration Manager now?

Click [Yes]. Continue to Chapter 4 to walk through the MyAssistant Server Configuration Manager.
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Additional Settings

Chapter 3 — MyAssistant Server Configuration

This chapter walks through MyAssistant Server Configuration Manager, where you will upgrade your
MyAssistant database and verify that all settings are still accurate. Configuring the server must be completed
before upgrading MyAssistant on any Workstations.

Read this section carefully:

You will complete the following steps to configure the MyAssistant Server:

Upgrade your MyAssistant database.

Confirm the prefilled file paths for Sage data folders

Confirm the prefilled Mail Server settings for sending emails with MyAssistant
Confirm the MyAssistant Server settings

NOTE: Reactivating the software and stepping through the Configuration Manager on the

MyAssistant Server will take approximately 10 minutes.

PwON P
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Additional Settings

Step 1 - Welcome

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path:
Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

@ My fssiskant Server Configuration Wizard = B
| i | Welcame To The Myhssistant Server 2]
Product Activation fou may need the following information to configure the My2ssistant Server:

My Assistant Database Connection

MyAssistant Datahase » Your MyAssiskant customer number and Activation codes

Sage 300 CRE Data Folders w The Windows passward for the Adminiskrator user,
Matification E-Mail Account

. » & Sage 300 CRE Operakor ID and password that MyAssistant will use bo access Sage 300 CRE data.
Server Opkions

» The email account which MyAssistant will use to send email messages,

| Show Advanced Options G

Mexk = Zancel

Only check Show Advanced Options if you are using a Web Proxy Server, or would like to define new
Microsoft SQL Server credentials to access MyAssistant data. It is highly recommended you do not change
SQL Server credentials, as those used by the MyAssistant Server prior to upgrade are remembered.
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Additional Settings

Step 2 — Product Activation

In most cases, MyAssistant will remember the Customer Number and Server Product Key previously used to
activate the MyAssistant Server.

@ Myfssistant Server Configuration Wizard = 3l
Welcome Product Activation @
| Produck &ckivation | Enter your customer number and server product key to activate Mybssistant Server,
Mydssistant Database Connection Cuskarner Murnbey
Myfssiskant Database Server Product Key
Sage 300 CRE Data Folders V| Use Web Proxy Server

Web Proxy Settings
Wweb Prowxy Address;

Motification E-Mail Account

Server Opkions
User MName:

Password:

Diarmair:

Activate

< Back Mext = Cancel

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the
information entered is accurate.

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options
in the Welcome Screen (Step 1).
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Additional Settings

Step 3 — Database Connection

D NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome
step.

@ MyAssistant Server Configuration Wizard 1 =l T
Welcome Connect to the MyAssistant Database e
Product Ackivation Llze the fields below to enter the computer name where the S0L Server databasze

i installed and to create a SOL Server Lser,

MyAssistant Database Connection

Enter the computer that the database is located at:

Mdssistant Database erver Name SERVER]

Sage 300 CRE Data Folders Create a username and password For MyAssistant bo access
the 0L Server:

Motification E-Mail Account
User Marmne My figsistant

Server Opkions
PassWDrd kR

Re-enter Password; | ek

Advanced Connection Settings

Instance name: | 15D
Database name:

Port number: 45312

= Back, Mexk = Cancel

E CAUTION: Making changes in this step can break the connection to the MyAssistant database.
Modifying these fields requires advanced knowledge of SQL Server database engines. It is highly
recommended that you do not make any changes in this step when upgrading your MyAssistant Server.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port
Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.
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Additional Settings

Step 4 — Upgrade the MyAssistant Database

MyAssistant will perform the necessary steps to upgrade your database.

Pz rayassistant Server Configuration Wizard o B B
welcome MyAssistant Database 7]
Product Activation My#ssistant meeds to upgrade your database to the newest version. This may take

a few minutes, Please click Mext to proceed with the upgrade.,
Mhrdssistant Database Connection
MyAssistant Dakabass |
Sage 300 CRE [uta Folders

HotFication E-Mail Acoount
Server Options Updating database: 80% completed. ..

< Back Next > Cancel

Click [Next] to upgrade the database.
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Additional Settings

Step 5 - Sage 300 CRE Data Folders

Verify that the information in this step is still accurate. These are the data folders MyAssistant will be able to
monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

@ MyBssistant Server Configuration Wizard = 3l
Welcome Define Sage 300 CRE Data Folders (2]
Product Activation Enter a Sage 300 CRE operator and password that MyAssistant will use to access Sage

300 CRE data,
Sage 300 CRE User:

Mwdssistant Database Connection

Mwdssistant Database Sage 300 CRE
Sage 300 CRE Data Folders password: 7] Shaw characters
Motification E-Mail Account Click, "&dd Diata Folder" to select the Sage 300 CRE data Folders vou would like to monitor with
My Assistant,
Server Opkions
Sage 300 CRE Folder Location Mame

2 g AaELTIMEERLIMNE OFFICE! .| Timberline Construction

4 k

Import Sage Dakabase Customizations Add Daka Folder

< Back Mext = Cancel

Click [Next] to continue. If there is more than one data folder entered, you will be prompted to select
which folder's Database Customizations to import. If there is only one data folder specified, Database
Customizations will be imported automatically.

If the Sage 300 CRE password entered above is set to expire, a warning message will appear. When the
password does expire, you will need to reopen the MyAssistant Configuration Manager and enter the new
password in this step. Updating the settings for this User account in Sage so the password never expires
is recommended.
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Additional Settings

Step 6 — Notification E-Mail Account

Verify your mail server settings are still accurate, or update them if they have changed.

@ My#ssiskant Server Configuration YWizard

=

[=]E

w'elcome

Product Ackivation

Mwdssistant Database Connection
Mydssistant Database

Sage 300 CRE Data Folders

Mokification E-Mail Account

Server Opkions

Maotficaton E-Mal Account

Lze the following to specify the e-mail account from which notification e-mail
messages will be sent on this server,

Fram Marme: My Assiskant

From E-mail Address:

Mail Server Settings
Cukgoing Mail Server:
Username:

Password:

Show characters

This server requires an encrypted S5L conneckion

\
< Back Mext = Cancel
Click [Next] to continue.
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Additional Settings

Step 7 — Server Options

This final step is used to determine a variety of settings around the MyAssistant Server.

@ Mydssistant Server Configuration Wizard - X

Server Cphons e

Welcome

Product Activation e ——

MyAssistant Database Daily Summary can be used ko send someone a list of notifications across multiple subjecks (Tasks)
Sage 300 CRE Data Folders Deliver summary emails at: | 4:00 am -

Matification E-Mail Account
Send Errors To

Server Opkions

Recipient narne:

Recipient email:

Browse, ..
Save Sage MyCommunicator Email Messages
Falder Lacation:
Autariatically save email associated with MyCarmmunicatar ackivity i

Running Tasks and Sending Service Settings

Dekerming the number of concurrent processes that will be used ta run Mydssistant Tasks and Send emails,

Concurrent processes ko run Tasks 41 Task timeout in minutes 60
Concurrent processes to send email 2| Sending Timeout in minukes |240) 2
< Back Finish Cancel

Daily Summaries: MyAssistant Daily Summary email messages are used to send each recipient their
notifications across several Tasks in one email message. See the MyAssistant User Guide for more
information. This time should be after all of your daily Tasks have run.

Send Errors To: Someone to be notified when MyAssistant encounters an error. It is recommended to
send error messages to the primary MyAssistant user.

Save MyCommunicator Email Messages:

Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to
your business. In addition to creating a record of business-related emails, a copy of the mail messages
can be saved and linked to your Sage data (e.g. Jobs, vendors, customers, etc.). To enable this function,
check the box in this section and click [Browse...] to select a folder location.

Running Tasks and Sending Service Settings:

MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background
processes (i.e. Windows Services) on the server. These processes are now scalable to increase
performance, and auto-correct in the event of a hang.
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Additional Settings

These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other
processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables
affect the system resources used when Tasks run and emails are sent, including:
e The available server memory
e Disk drive performance
e Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at
night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

e Complete the MyAssistant server configuration with the default settings and the MyAssistant
workstation installation.

e Activate two MyAssistant Tasks you will regularly use.

e Use the Windows Task Manager and the Resource Monitor to track server memory usage and
disk queue lengths when both Tasks are run concurrently.

e Open the MyAssistant Configuration Manager and increase or decrease the number or processes

based on available server resources.
Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant installation is complete.
Continue to Chapter 5 to install the MyAssistant Workstation.
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Workstation Upgrade

Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (e.g. drive letter “T:”) to access your Sage 300 CRE data or Program Files, you
need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows
Service that runs MyAssistant Tasks to access your Sage 300 CRE database or programs.

How do | know if | am using the Drive Mapper?
Perform the following:

1.
2.
3.

Log on to the server where the MyAssistant server is installed
Open Windows Explorer
Go to the folder where the MyAssistant Program Files are installed. If you accepted the default
location when installing the software, the MyAssistant Program Files will be in the following
location:

C:\Program Files (x86)\Innovative Software Design\MyAssistant
Look for a file named InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll in the
MyAssistant, Task Service, or Sender Service folders.

If this file exists, you are using the MyAssistant Drive Mapper and it will need to be updated in all three
locations (the MyAssistant, Task Service and Sender Service program folders).

1d

CAUTION: The MyAssistant Drive Mapper must be used if you are using mapped drives to access

your Sage 300 data files or Program Files. If you are using UNC paths and do not use any mapped drives,
you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssistant Drive Mapper:

1.

Log on to the computer where the MyAssistant Server is installed using the account that activated the
MyAssistant Server. Often this is an Administrator account.

Open the folder containing the MyAssistant installation files. This will be a location you selected when
saving the files. There is no default location.

Using Windows Explorer, copy and replace the file
InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll from the Tools >
DriveMapperCommand folder in the MyAssistant installation files to the folder where the MyAssistant
software has been installed. If you accepted the default location when installing the MyAssistant
software, this location will be C:\Program Files\Innovative Software Design\MyAssistant.

The InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll also needs to be placed
in the following locations:

a. Program Files\Innovative Software Design\MyAssistant\Sender Service
b. Program Files\Innovative Software Design\MyAssistant\Task Service

Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService
from the Windows Services window. Follow the instructions below to do this.

Click to open the Start menu and click [Run]

In the Run box type services.msc to open the Windows Services window
Look down the list for ISDAdminTaskService and ISDAdminSenderService
Restart both of these services.

PwnNPE

The MyAssistant Drive Mapper tool is now upgraded.
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Workstation Upgrade

Chapter 4 — Upgrading the MyAssistant Workstation(s)

IMPORTANT: If you are upgrading a Terminal or Citrix Server, please go to Chapter 6.

Perform the following to initiate the MyAssistant Workstation upgrade.

1. Log on to your Sage 300 MyAssistant workstation as the Windows user who has MyAssistant
activated.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running.

3. If accessible from the Workstation, open the same folder of unzipped MyAssistant install files
used to upgrade the MyAssistant Server. If not, perform the following to initiate the MyAssistant
Workstation Upgrade:

a) Download the MyAssistant Installation files and open the folder they were downloaded to.
b) Unzip the files to a folder on the local drive of the Workstation.
c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

Sage 300

Construction and Real Estate

MyAssistant

Version 18.1.5
» View Installation Guide.

» Install Server.

» Install Workstation.

| SageCRE.com | Exit |

Select [Install Workstation] to perform a MyAssistant Workstation upgrade.
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Workstation Upgrade

Step 1 - Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will
appear:

m MyhAssistant - Setup Workstation
Welcome Welcome to the MyAssistant Installer
Thiz wizard will guide vou through the Mydssistant installation process. You
Inztall Prereqiuzites may be azked to restart your spstem after installing prerequisites.

®  Prerequisites

®  Muydsgziztant

Befare continuing installation, please close all applications [such as Microzoft
Outlook, Yirus Scanners, and Spyware Detectors), since they can interfere
with the My Aszigtant installabion.

Mest » Cancel

Click [Next] to continue.
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Workstation Upgrade

Step 2 — MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the
Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

m My Assistant - Setup Workstation

License Terms for MyAssistant

License Terms IMPORTANT - READ CARFEFULLY: This il
Inztall Preregiuzites Software License Agreement (the “Agreement’™
iz a legal agreement between wou - either an
indrrdual or a single entity - the (“Licensee™ and
Innovative Software Design, Inc. ("TSD™). This
Aoreement applies to the computer software, n
machine readable fortn, that accompaties this
A oreement (the “Software™), updates,
documentation  and related serwices.  YOU
AGEEE TO BE BOUIND BEY THE TEEMS COF
THIZ AGEEEMINT BY CLICEING “1
ACCEPT THE  TEEMS OF THIS
AGEEEMENT", INSTALLING, COPYING,
OF TEING THE SOFTWARE. IF YOI DO
HMOT AGEEE, DO NOT INSTALL, COPY,
Ok TUSE THE SOFTWARE, YTOU MMATYT
EETUEXT IT TO 7YOUE PLACE OF
PTUECHASE FOR A FULL EEFUND.

¥ accept the terms in the license agreement

Mest » Cancel |

Click [Next] to continue.
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Workstation Upgrade

Step 3 — Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no
software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all
prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

Step 4 - Install the Software

Select the location where the MyAssistant Program Files will be installed.

m My Assistant - Setup Workstation
[Ty Assistant

The default location where the Mydzsizstant progran files will be installed
toiz C:AProgram Files' nnovative Software Designtddy desigtants, vou
Inztall Preregiusites may uze the Browse button to specify a different location on wour local

_ camputer,
Inztall ks zzistant

Select a location to install Mydssistant:
IC:\F‘rngram Files [#BE]\nnovative Saftware DesigniMy Azsistant

Browse... |

Meut » Cancel

Accept the default location or use the [Browse] button to specify a different location. It is recommended that
you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant software on the workstation.
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Workstation Upgrade

Step 5- You have Completed Installing MyAssistant

Congratulations. MyAssistant has been successfully upgraded on this machine.

m My Assistant - Setup Workstation

Yol have completed instaling MyAssistant

o Congratulations! v'ou have finished instaling Mpdzziztant. When vou launch
Irestall Prereqiusites rudzziztant for the firzt time pou will be asked to provide zome basic information
to activate and connect to the Mydasistant Server,

Finizhed

Firish |

Click [Finish] to close the setup wizard.
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Workstation Configuration

Chapter 5 — MyAssistant Workstation Configuration

E] NOTE: In most cases, MyAssistant remember prior settings and open automatically. However, in
some instances you may be required to complete the User Configuration Wizard.

Step 1 — Welcome Screen

Double click on the MyAssistant icon on the desktop to open the MyAssistant Configuration Wizard.

@ My Assistant User Configuration YWizard = &
| TR | Welcorme To MyAssistant e
Product Activation “ou may need to the following information to configure Myassistant:

Sage 300 CRE Data Folders

Your Settings & our MyAssiskant customer number and Activation codes

| Shows Advanced Options

Mexk =

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Start > All Programs > MyAssistant (File) > MyAssistant
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Workstation Configuration

Step 2 — Product Activation

All settings in this step should be prefilled from the last time MyAssistant was activated on this computer.
Confirm MyAssistant is activated, and that any Web Proxy Settings are up-to-date.

@ MyAssistant User Configuration Wizard o (B ER
welcome Product Activation a
| Product Activation | Enter your customer number and user product key to activate My&ssistant for user
Adrinistrator on this computer, The MyAssistant product key determines the
Sage 300 CRE Data Folders My assistant features available to user Administrator on this computer,

our Setkings Cuskarmer Number
Ty Assiskant Produck Key
W | se Web Proxy Server

Web Proxy Setkings
Web Proxy Address:

User Marme:
Password:

Domain:

Ackivate fckivake Laker

< Back ek =

@ NOTE: The Web Proxy Server connection fields will only be available if you clicked [Show Advanced
Options] in the Welcome step.

Click [Next] to continue.
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Workstation Configuration

Step 3 — Entering Sage 300 CRE Data Folder Information

Confirm the Sage login credentials and Sage data folder paths are still accurate.

E] Mwdssistant User Configuration wizard o = OEE
weleome Define Sage 300 CRE Data Folders @
Product Activation Enter your Sage 300 CRE user name and password.

Sage 300 CRE Data Folders | e 300 CRE L | |
age SEL

Your Setkings || |

Sage 300 CRE
password:

Show charackers

Click in the Sage 300 CRE Folder Location column bo specify a data folder, IF any Sage 300 CRE data folders
were prefiled wverify the path.

Ignore | Sage 300 CRE Faolder Location | Wame
[ - ZHProgrambatalSAEEl TIMBERLIME OFFICEY. .. | Timberline Construction

< Back. Mext = Cancel

Click [Next] to continue.
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Workstation Configuration

Step 4 — User Profile

This step shows the personal information for the Windows user on this workstation, which should prefill.

@ Myfssistant User Configuration Wizard = = 2
\Welcoms Your Personal Information
Product Activation Enter the person's name and e-mail address for the current Windows User,

Sage 300 CRE Data Folders

Your Settings Windows User: Adrniniskrakor

Yaur Mame:

Your E-mail Address:

W | Showe Motifications in the Sage 300 CRE Deskkop
o | Display Mydssistant Alerts in the System Tray

W | Showe Myassistant Tile on the Deskiop

< Bark Finish | [ Cancel

Click [Finish] to close the wizard and open MyAssistant.
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Terminal Server Upgrade
Chapter 6 — Upgrading a Terminal Server

CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at
least one MyAssistant User on a Terminal or Citrix Server.

What is Involved

Perform the following to upgrade MyAssistant on a Terminal or Citrix Server:

Log on to the Server as the Windows user that activated the MyAssistant Server.
Run the MyAssistant Server installation to upgrade.

Confirm the settings in the Server Configuration Manager.

Log on to the machine with the Windows user who uses MyAssistant.

Open the MyAssistant user Application.

If needed, confirm previous settings for user configuration.

oukrwnE

Before Upgrading
Before MyAssistant can be upgraded on any accounts other than the administrator, permissions must be
given to specific files. The default paths have been provided for your convenience below:

e C:\Program Data
e C:\Program Files\Innovative Software Design
OR
e C:\Program Files(x86)\Innovative Software Design

I IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant

users on this machine.

Upgrading the MyAssistant Server

Complete to Chapters 1 through 4 for upgrading the MyAssistant Server. When you have completed
Chapter 4, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix
Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is upgraded and configured, log onto the Terminal or Citrix Server as the
Windows user who will be using the MyAssistant software.

o |Ifthere is a MyAssistant icon on the desktop, double click to open the User Configuration

Manager.
e If there is not an icon on the desktop follow this path:
Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open complete the steps in Chapter 6 to activate the
MyAssistant workstation.
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Conclusion

Chapter 7 — Test the Upgrade

Confirm MyAssistant is working properly by testing the following:

Access Sage 300 CRE Data
1. Open the MyAssistant Designer software from a MyAssistant Workstation.
2. Open an activated MyAssistant Task.
3. Move to the Email step in Task Setup.
4. Expand the very first record in the list of available Sage 300 CRE database records (on the right
side of the window).
Right click on the first field and select [Browse Data].
The data contained in the field should be displayed in the Browse Data window.

oo

Troubleshooting
1. Ifclicking [Browse Data] returns an error:
a. Inthe main MyAssistant window, select File > [Options] to open the Options window.
b. Move to the Sage 300 CRE Data Folder step.
c. Click [Test Connection] to confirm that the Sage 300 CRE credentials entered are able to
access the Sage data. If the test fails, update the credentials.
d. Contact Sage Support if the credentials are correct but you still receive an error when
browsing.
2. If clicking [Browse Data] results in a blank Browse Data window, that field may not have data.
Try another field in the same record.

Run Tasks and Receive Email Messages
1. Open the MyAssistant software from a MyAssistant Workstation.
2. Browse to an activated Task. If possible, select a Task with an attached Crystal Report that is
being sent to you (edit the recipient list as needed).
3. Right click on the Task and click [Run and Send].

Troubleshooting
1. |If the Task doesn’t finish running:
a. Log onto the MyAssistant Server.
b. Open the Windows Services window (Start > Run > type: Services.msc).
c. Look for the ISDAdminTask and ISDAdminSender services. Confirm both are started.

2. If the Task finishes running but an email is not received:
a. Click the Reports tab, then [Notifications Not Sent]. If you see Notifications, click the
Refresh button once every thirty seconds until you see “No notifications to send.”
b. If you still don’t receive an email:
a. Open the Windows Services window (Start > Run > type: Services.msc).
b. Look for the ISDAdminSenderService. Right click on the service and select
[Properties].
c. Click the [Log On] tab.
d. Select [This account] and enter a Windows user that is associated with a person
who is an administrator in the Sage 300 CRE software.
e. Click [OK] and then restart the Service.

Conclusion
This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way
around the updated software. Please refer to the User Guide for information on using MyAssistant.
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